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File types
(Raw, Analyze, DICOM 3.0, GE, Siemens, Bruker, Interfile, 

Micro cat, MINC, MRC, FITS, Cheshire, AFNI, TIFF, JPEG, GIF, 
BMP, AVI, QuickTime, Biorad, Ziess LSM510, XML, and more)

Data (Image) types: n-dimensional structure
(boolean, byte, unsigned byte, short, 

unsigned short, int, long, float, double, Complex, ARGB)

Views – with data fusion
  2D planar, 
 “Lightbox”, 
  Cine (movie),
  Multi-planar, 
  3D tri-planar, 
  Surface render, (supports 3D texture
        mapped volume rendering  
  Volume render

Algorithms
   Filtering
   Segmentation/classification
   Measurement/quantification
   Registration/fusion
   Utilities
   Plugins

VOIs

32K
Manual and 
automated 
contouring

Functional OverviewFunctional Overview  

PACS 
DICOM 3.0: 

Query/Retrieve, Catcher

GUI
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Code SnapshotCode Snapshot
int destExtents[] = new int[2];
destExtents[0] = image.getExtents()[0];    // X dim
destExtents[1] = image.getExtents()[1];    // Y dim

// Make a result image of Unsigned byte type
resultImage     = new ModelImage(ModelStorageBase.UBYTE, destExtents, “Result Image”, null);

int length = destExtents[0] *  destExtents[1];
for (int i = 0; i < length; i++){
     destImage.set(i, i%256);
}

ViewJFrameImage imageFrame; 
ModelLUT LUTa   = new ModelLUT(ModelLUT.COOLHOT, 256, dimExtentsLUT);
          imageFrame = new ViewJFrameImage(resultImage, LUTa, new Dimension(610,200), userInterface);
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Major Algorithms Supported
• Algorithms

– Filters: Gaussian blurring, gradient magnitude, Laplacian, curvature, other higher order 
derivatives, median, anisotropic diffusion, coherence-enhance diffusion, isotropic diffusion, 
wavelet, unsharp masking, etc.

– Image Calculator (add, subtract, multiply, divide, AND, OR, XOR)
– Registration

• Landmark – least squares, thin-plate splines for both 2D and 3D datasets
• AIR 5.07 and AFNI
• Automatic 2D/2.5D/3D registration intra/inter patient, intra/intra modality

- multi-resolution, user selectable DOF, user selectable cost function (correlation ratio, 
normalized cross correlation, least squares, mutual information.   

– Image transformations or resample with nearest neighbor, tri-linear, 3rd, 4th bSpline, Sinc, 3rd, 5th, 
7th order Lagrangian, etc.

– Surface extraction with decimation
• Adaptive skeleton climbing
• Marching cubes
• Marching tetrahedrons

– Skull striping
– Classification – Fuzzy c-means 
– Watershed
– Morphological filters (open, close, erode, dilate, etc )
– Active contour methods (GVF etc. )
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Download and SetupDownload and Setup
1. http://mipav.cit.nih.gov/download
2. Fill in form
3. Install (e.g. installMIPAV.exe)
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Scripting & PluginsScripting & Plugins
• Scripts - Automation of MIPAV functions applied to a 

group of datasets to increase efficiency and productivity

• Plugins – Ability to add unique functionality to MIPAV 
by developing new algorithms using MIPAV’s API
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PluginsPlugins

• Pure Java/MIPAV plugin
– Unique functionality.

• MIPAV to C, system call, Python, Perl etc.

• MIPAV to ITK (a C++ imaging library).
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PluginsPlugins
• Four steps to building a plugin

– 1. Determine type of plugin ( usually Algorithm )
– 2. Determine Java version to use 

• Use the same version javac as MIPAV (Help -> About Java)
– 3. Write the plugin
– 4. Compile the plugin
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Plugins Plugins 

• PlugInAlgorithm – Develop new functionality and ability PlugInAlgorithm – Develop new functionality and ability 
to call functions already in MIPAV.to call functions already in MIPAV.

• PlugInFile – Develop files readers to support unique file PlugInFile – Develop files readers to support unique file 
formats. Rarely used since MIPAV supports numerous formats. Rarely used since MIPAV supports numerous 
file formats.file formats.

• PlugInGeneric – Generic plugins that do not require an PlugInGeneric – Generic plugins that do not require an 
open imageopen image

• PlugInView – Develop new visualizations of datasets. PlugInView – Develop new visualizations of datasets. 
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Plugins Plugins 
• To build a plugin, three files are typically required:To build a plugin, three files are typically required:

– PlugInFoo.java PlugInFoo.java 
• interface to MIPAV and the plugininterface to MIPAV and the plugin

– PlugInDialogFoo.javaPlugInDialogFoo.java
• invokes the dialog to get user supplied parameters – can be invokes the dialog to get user supplied parameters – can be 

hidden when no parameters are required hidden when no parameters are required 
– PlugInAlgorithmFoo.javaPlugInAlgorithmFoo.java

• The actual algorithm to be implemented. It can be a mixture of The actual algorithm to be implemented. It can be a mixture of 
calls to MIPAV’s API, C programs, Perl, ITK, etc.calls to MIPAV’s API, C programs, Perl, ITK, etc.
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Plugins - Location Plugins - Location 

• Stored for each user in $home/mipav/pluginsStored for each user in $home/mipav/plugins

– Windows   -  C:\Documents and Settings\user_name\mipav\pluginsWindows   -  C:\Documents and Settings\user_name\mipav\plugins

– Unix/Mac  - usually /home/user_name/mipav/pluginsUnix/Mac  - usually /home/user_name/mipav/plugins

– Note: By default, the home directory of the user who installed Note: By default, the home directory of the user who installed 
MIPAV is used.  If you are running plugins as a different user, set the MIPAV is used.  If you are running plugins as a different user, set the 
classpath before running mipav:classpath before running mipav:

• % CLASSPATH=$HOME/mipav/plugins/ /path/to/mipav% CLASSPATH=$HOME/mipav/plugins/ /path/to/mipav
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Plugins - MIPAV API Plugins - MIPAV API 
http://mipav.cit.nih.gov/documentation/api/

http://mipav.cit.nih.gov/documentation/api/
http://mipav.cit.nih.gov/documentation/api/
http://mipav.cit.nih.gov/documentation/api/
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Plugins - Documentation Plugins - Documentation 
• Plugin development documentation

•http://mipav.cit.nih.gov/documentation/userguide/volume1/MIPAV_PlugIns.pdf

•Using ITK from MIPAV
http://mipav.cit.nih.gov/documentation/techguides/TechGuide2_UsingInsightToolkit.pdf

•This presentation will be posted at 
http://mipav.cit.nih.gov/documentation/presentations/ in the next couple of weeks.

http://mipav.cit.nih.gov/documentation/userguide/volume1/MIPAV_PlugIns.pdf
http://mipav.cit.nih.gov/documentation/techguides/TechGuide2_UsingInsightToolkit.pdf
http://mipav.cit.nih.gov/documentation/presentations/
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Plugins – InstallingPlugins – Installing
• Installation of a simple plugin (Installation of a simple plugin (Plugins -> Install Plugin))

Copies files
- Chosen .class files, or the contents selected of jar/zip files

into the directory
- $home/mipav/plugins 
When MIPAV starts, it parses this directory and builds the plugins menu.

Note: 
Simply use the OS’s tool for coping the files into the directory listed above is
also acceptable. The user will be required to restart MIPAV to have the new plugin 
appear in the menu.
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Plugins – InstallingPlugins – Installing
• Installation of a complex plugins Installation of a complex plugins 

– Medic Talairach pluginMedic Talairach plugin
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Plugins – Installing LabPlugins – Installing Lab

• InstallInstall
• PlugInCT_MD.class PlugInCT_MD.class 
• PlugInDialogCT_MD.classPlugInDialogCT_MD.class
• PlugInAlgorithmCT_MD.classPlugInAlgorithmCT_MD.class
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Medic PluginsMedic Plugins
    

The Medic plugins are being ported to be compatible with the 
3.0.0 release of MIPAV.  3.0.0-compatible versions of their 
plugins are expected soon.

http://medic.rad.jhmi.edu/download/public/index.shtml

http://medic.rad.jhmi.edu/download/public/index.shtml
http://medic.rad.jhmi.edu/download/public/index.shtml
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Plugins Plugins 
• package gov.nih.mipav.plugins;package gov.nih.mipav.plugins;

• import gov.nih.mipav.model.structures.*;import gov.nih.mipav.model.structures.*;
• import gov.nih.mipav.view.*;import gov.nih.mipav.view.*;

• import java.awt.*;import java.awt.*;

• public public interfaceinterface PlugInAlgorithm extends PlugIn { PlugInAlgorithm extends PlugIn {

•         /**/**
•         *   run *   run 
•         *   @param UI                  MIPAV main user interface.*   @param UI                  MIPAV main user interface.
•         *   @param parentFrame  Frame that displays the MIPAV image.*   @param parentFrame  Frame that displays the MIPAV image.
•         *                                        Can be used as a parent frame when building dialogs.*                                        Can be used as a parent frame when building dialogs.
•         *   @param image             Model of the MIPAV image. *   @param image             Model of the MIPAV image. 
•         *   @see   ModelImage*   @see   ModelImage
•         *   @see   ViewJFrameImage*   @see   ViewJFrameImage
•         */*/
•         public void public void run run (ViewUserInterface UI, Frame parentFrame, ModelImage image);(ViewUserInterface UI, Frame parentFrame, ModelImage image);

• }}
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Plugins – Hello WorldPlugins – Hello World
import gov.nih.mipav.plugins.*;     //needed to load PlugInAlgorithm / PlugInView / PlugInFile interface
import gov.nih.mipav.view.*;       
import gov.nih.mipav.model.structures.*;

import java.awt.*;
import javax.swing.*;

/**
 * <p>
 * This is simple plugin to display a dialog – hello world.
 * </p>
 * <p>
 * This is a Algorithm type of PlugIn, and therefore must implement PlugInAlgorithm
 * Implementing the PlugInAlgorithm requires this class to implement the run method
 * with the correct parameters.
 * </p>
 *
 * @see PlugInAlgorithm
 */
public class PlugInHello implements PlugInAlgorithm {

     /**
      * Defines body of run method, which was declared in the interface.
      * @param UI User Interface
      * @param parentFrame Parent frame
      * @param image Current ModelImage - this is an image already loaded into MIPAV. Can be null.
      */    
      public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image) {
            JOptionPane.showMessageDialog( null, “Hello World!”, “Title-Greetings", JOptionPane. INFORMATION_MESSAGE );
      } 
}
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Plugins - ExamplePlugins - Example  
• import gov.nih.mipav.plugins.*;     import gov.nih.mipav.plugins.*;     //needed to load PlugInAlgorithm / PlugInView / PlugInFile interface//needed to load PlugInAlgorithm / PlugInView / PlugInFile interface
• import gov.nih.mipav.view.*;       import gov.nih.mipav.view.*;       
• import gov.nih.mipav.model.structures.*;import gov.nih.mipav.model.structures.*;

• import java.awt.*;import java.awt.*;

• /**/**
• *   This is simple plugin for the University of Maryland to simple segment an image based on CT Hounsfield units*   This is simple plugin for the University of Maryland to simple segment an image based on CT Hounsfield units
• **
• *   @see PlugInAlgorithm*   @see PlugInAlgorithm
• */*/

• // This is a Algorithm type of PlugIn, and therefore must implement PlugInAlgorithm// This is a Algorithm type of PlugIn, and therefore must implement PlugInAlgorithm
• // Implementing the PlugInAlgorithm requires this class to implement the // Implementing the PlugInAlgorithm requires this class to implement the runrun method method
• // with the correct parameters// with the correct parameters
• public class PlugInCT_MD implements public class PlugInCT_MD implements PlugInAlgorithmPlugInAlgorithm { {

•       /**/**
•             *   Defines body of run method, which was declared in the interface.*   Defines body of run method, which was declared in the interface.
•             *   @param  UI                 User Interface*   @param  UI                 User Interface
•             *   @param  parentFrame  Parent frame*   @param  parentFrame  Parent frame
•             *   @param  image            Current ModelImage - this is an image already loaded into MIPAV. Can be null.*   @param  image            Current ModelImage - this is an image already loaded into MIPAV. Can be null.
•             */    */    
•             public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image) {public void run (ViewUserInterface UI, Frame parentFrame, ModelImage image) {

•                     if (parentFrame instanceof ViewJFrameImage)if (parentFrame instanceof ViewJFrameImage)
•                             new PlugInDialogCT_MD (parentFrame, image);new PlugInDialogCT_MD (parentFrame, image);

•                     elseelse
•                             MipavUtil.displayError ("PlugIn CT_MD only runs on an image frame.");MipavUtil.displayError ("PlugIn CT_MD only runs on an image frame.");
•                   }}
•         } } 
• }}
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Plugins - Dialog Plugins - Dialog 

PlugInDialogCT_MD.java
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Plugins - Algorithm Plugins - Algorithm 

PlugInAlgorithmCT_MD.java

Simple algorithm to segment an image based on Hounsfield values
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Plugins - InstallingPlugins - Installing

Be sure to select the files to be moved into the user’s directory (e.g. 
PlugInFoo.class, PlugInDialogFoo.class and PlugInAlgorithmFoo.class).

** This is nearly the same as manually coping the files into the user’s directory.
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Plugins - ExecutingPlugins - Executing
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Plugins to system callsPlugins to system calls
    

• if (os != Preferences.OS_MAC) {
•          int response = JOptionPane.showConfirmDialog(this, "Restart MIPAV to apply memory changes?",
•                                        "Restart needed",
•                                        JOptionPane.YES_NO_OPTION, JOptionPane.INFORMATION_MESSAGE);
•           if (response == JOptionPane.YES_OPTION) {
•                  if (os == Preferences.OS_WINDOWS) {
•                                // “./mipav.exe” could be replaced with a precompiled c++  program for example.
•                               Runtime.getRuntime().exec("./mipav.exe"); 
•                  }
•                  else {
•                               Runtime.getRuntime().exec("../runmipav");
•                  }
•                  System.exit(0);
•            }
•  }
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Setting up development Setting up development 
environmentenvironment

    

• To build a new plugin for MIPAV, the user must first install a build 
environment, alter the PATH environment variable, and compile the 
plugin files.
– Install the Java 2 SDK version 1.5. 
– Install Apache Ant 1.6.X. 
– Add JAVA_HOME to your environment, pointing to the directory where the 

SDK is installed (e.g. C:\Program Files\Java\jdk1.5.0_06). 
– Add ANT_HOME to your environment, pointing to the directory where Ant 

is installed (e.g. C:\Program Files\apache-ant-1.6.3). 
– Add the bin directories under ANT_HOME and JAVA_HOME to your 

PATH environment variable (e.g. add  - %
JAVA_HOME%\bin;%ANT_HOME%\bin to the end of PATH). 

http://java.sun.com/
http://ant.apache.org/
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Setting up development Setting up development 
environment (continued)environment (continued)

    

– Retrieve our example Ant build file and place it in the same directory as the 
plugin .java files you want to compile. 

– Alter the dir.mipav and dir.jdk properties within the build.xml to point to the 
directory where MIPAV and the SDK are installed, respectively. 

– Type in "ant compile" (without quotes) into a terminal window (e.g. cmd on 
Windows or xterm on unix platforms). 

– BUILD SUCCESSFUL should appear at the end of the Ant output. 
– Copy the .class files that Ant produced into MIPAV's plugin directory 

(C:\Documents and Settings\username\mipav\plugins or 
/home/username/mipav/plugins). 

– Install the plugin file using MIPAV (Plugins -> Install Plugin). 

http://mipav.cit.nih.gov/documentation/presentations/plugins/build.xml


30

<!-- build file for MIPAV plugin class -->
<project basedir="." default="compile" name="mipav_plugin">
     <property name="dir.mipav" value="c:\\Program Files\\mipav\\"/>
     <property name="dir.jdk" value="c:\\Program Files\\Java\\jdk1.5.0_06"/>
     <target name="init">
          <tstamp/>
          <path id="build.classpath">
               <pathelement path="${dir.mipav}"/>
               <pathelement location="${dir.mipav}/InsightToolkit/lib/InsightToolkit/InsightToolkit.jar"/>
              <fileset dir="${dir.mipav}">
                   <filename name="*.jar"/>
             </fileset>
          </path>
         <property name="build.cp" refid="build.classpath"/>
     </target>
     

Build XML exampleBuild XML example
    



31

<target name="compile" depends="init">
          <echo>classpath: ${build.cp}</echo>
          <javac debug="true" deprecation="true" description="Builds MIPAV" verbose="no“

 listfiles="yes" nowarn="no" fork="true" memoryInitialSize="220M“
 memoryMaximumSize="1000M" id="mipav build" source="1.4“
 target="1.4" destdir="." srcdir="." compiler="modern">

             <classpath refid="build.classpath"/>
         </javac>
     </target>
     <target name="clean" depends="init">
          <delete>
              <fileset dir=".">
                  <include name="**/*.class"/>
              </fileset>
        </delete>
     </target>
</project>

Build XML example (cont)Build XML example (cont)
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Modify Plugin LabModify Plugin Lab
• Edit PlugInHello.java

• Change the message from “Hello World!” to:
“Hello ” + image.getImageName() + “!”

• Compile PlugInHello.java using the plugin build.xml

• Install the generated PlugInHello.class into MIPAV

• Open an image

• Run the Hello plugin
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Summary Summary 

• PluginsPlugins
– Unique functionality using MIPAV APIUnique functionality using MIPAV API
– Can be used to call C, System, Python, JPython, Perl, Can be used to call C, System, Python, JPython, Perl, 

etc. programs etc. programs 
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Visualization

Ubiquitous 
file reader

Quantification File writer

Processing Macros/Plugins


